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Chapter 3.Fundamentals
Do Not Skip This Section

3.1    Starting Out
When you begin Monocle, the following screen will be displayed.    

Note:    If the Autoload feature was previously selected from the fund groups dialog box, a fund group will be 
loaded on startup and a    mutual fund's price history will be displayed.

There are three icon bars which simplify access to the most commonly used features of Monocle:

1.          Tool Bar - Provides access to the primary functionality of the program 
                including the various statistics, indicators, and windowing commands.
2.          Draw Bar - Provides access to the various drawing commands
                including Trendlines and Fibonacci Arcs.
3.          Status Bar - Displays helpful information in its different windows and
                allows for selection of the Current Fund.

Note: If there are no fund groups open, there are only four options available: Fund Groups, Downloader, Help, 
Exit.



3.2    Tool Bar
The Tool Bar provides push button access to the major functionality of Monocle.    It is located near the top of the 
program window and can be toggled On or Off from the Windows menu.

The Tool Bar is composed of the following items in the order of their appearance from left to right.

 
1.          Fund Groups Icon:    Allows you to open, add, delete, and edit a fund
                group.
2.          Indicators Icon:    Allows you to select and edit indicators for the active
                fund group.
3.          Statistic Groups Icon: Allows you to open, add, delete, and edit a 
                statistic group.
4.          Fund Portfolios Icon: Allows you to open, add, delete, and edit a
                fund portfolio for the active fund group.
5.          Load Individual Fund Icon:    Allows you to display any fund from the
                Monocle database.
6.          Fund Description Icon:    Displays a brief description of the Current
                Fund.
7.          Latest Pricing Icon:    Displays the most current day’s pricing for the
                funds in the active fund group. 

 
8.          Trading System Icon - Allows you to view, add, delete and edit trading
                systems.    The Monocle Trading System is a system add-on.    Please
                contact Manhattan Analytics for additional information.



 
9.          Tile Fund Groups Icon: Tiles the fund group windows to fill the available
                area of Monocle.
10.      Cascade Fund Groups Icon: Cascades the fund group windows within the
                available area of Monocle.
11.      Tile Child Windows Icon:    Tiles the child windows to fill the active fund 
                group window.
12.      Stack Child Windows Icon:    Stacks the child windows vertically to fill the
                active fund group window.
13.      Cascade Child Windows Icon:    Cascades the child windows within the active
                fund group window.

 
14.      Align Dates Icon: Sets the period displayed for all indicator windows
                within a fund group window to the period of the active indicator 
                window.
15.      Zoom In Icon:    Allows you to zoom-in on a specific period within the
                active indicator window.
16.      Zoom Out Last Icon:    Allows you to zoom back to the previous period if 
                one was defined, otherwise the entire loaded history will be displayed. 

 
17.      Print Icon:    Enables you to print any window of the active fund group.
18.      Monocle Downloader Icon:    Starts the Monocle Downloader where you
                can update your database and transmit messages to and from Manhattan 
                Analytics.
19.      Help Icon:    Opens the on-line Help file.



3.3    Draw Bar
The Draw Bar provides push button access to the drawing functions of Monocle.    It is located on the left edge of 
the program window and can be toggled On or Off from the Windows menu.

The Draw Bar is composed of the following commands in the order of their appearance from top to bottom.

    ERASE    

 TRENDLINE

 EXTENDED TREND LINE

      VERTICAL LINE

    HORIZONTAL LINE

    INTERSECTING LINES

    PITCHFORK

    CYCLE LINES

    FIBONACCI FANS

    FIBONACCI ARCS

    FIBONACCI TIME ZONES

 TEXT

Note: The text icon is not displayed on monitors with a resolution less than 800 x 600.



3.4    Status Bar
The Status Bar displays information to assist you in the use of Monocle.    It is located on the bottom of the program 
window and can be toggled On or Off from the Windows menu.

The Status Bar is composed of the following items in the order of their appearance from left to right.

1.          Icon Information Window - Displays the name of the icon over which
                the mouse is positioned.    This allows you to quickly determine the
                function of an icon by positioning the cursor over it.
2.          Drawing Function Information Window - Displays the status of the
                selected drawing function.    For example, when the Fibonacci Arc
                function is chosen, you are prompted to "Select First Point."
3.          Previous Fund Icon - Sets the Current Fund to the previous fund in the
                fund group.
4.          Select Current Fund Icon - Allows you to directly select the Current Fund
                from the funds in the fund group.
5.          Next Fund Icon - Sets the Current Fund to the next fund in the fund group.
6.          Symbol Window - Displays the symbol of the Current Fund.
7.          Fund Name Window - Displays the name of the Current Fund.



3.5    Fund Groups
Monocle is designed around the concept of fund groups.    Nearly all aspects of the program revolve around the fund 
group.    Understanding this concept is fundamental to effectively using Monocle.    

A fund group is comprised of the following:

*            Name - The name of the fund group which is located
                on the fund group window title bar.
*            Set of funds - The mutual funds to be analyzed.
*            Benchmark - A fund or index against which the funds
                in the group are compared.    The Benchmark is located
                following the fund group name on the fund group window 
                title bar.
*            Period - The length of time the funds in the group are
                to be loaded.

Note: A fund group must be opened before any analysis can be performed.

A fund group contains a set of funds with a defined Benchmark.    The funds in the group are selected from the 
Monocle database. The Benchmark for the group is a fund or index against which the funds in the group are 
compared.    For example, to analyze the funds in the group against the market, you can select a mutual fund that 
approximates the market to be the Benchmark, like Fidelity's US Equity, FUSEX.    Remember, for your data to 
have meaning, choose a suitable benchmark.

Note: To aid in your analysis of mutual funds, Monocle also tracks many accepted market indexes, such as the 
S&P 500.    Monocle allows you to select any fund or index in the database to serve as the Benchmark.    One word of
caution when using true indexes as benchmarks: investing in an index is not comparable to investing in a mutual 
fund.

Monocle comes with fund groups for over 150 of the most popular mutual fund families.    For example, the Fidelity 
Investments group contains over 100 Fidelity Mutual Funds.    Additionally, Monocle includes fund groups for over 
20 investment objectives, such as Aggressive Growth and Income.

Note: Multiple fund group can be open simultaneously.



To open a fund group:

1.          Choose Fund Groups from the Tool Bar or the File menu.    

 
                A dialog box will be displayed listing the available fund groups.    

 
2.          Select a fund group from the list.
3.          Click on Ok.    
                This will create a fund group window and load the funds in the group. 
                A Price History indicator will be opened displaying the performance
                of the Current Fund versus the Benchmark.

The name of the fund group and the Benchmark are displayed on the title bar of the fund 
group window while the name and symbol of the Current Fund are displayed on the Status 
Bar.    Once a fund group is loaded, analysis can be performed on the funds within the group.



3.6    Current Fund
The Current Fund is the fund upon which the various indicators (Price History, MACD, etc.) operate.    When a fund
group is opened, the first fund in the group becomes the Current Fund.

For example, assume that the Current Fund is FDCAX (Fidelity Capital Appreciation) and that the Benchmark is 
FMAGX (Fidelity Magellan).    If the Price History chart is displayed, the two items charted are the Current Fund, 
FDCAX, and the Benchmark, FMAGX.



3.7    Active Indicator Window
The active indicator window is the window within the active fund group window that receives commands from the 
icon bars or the menu.    Only an indicator window (Price History, Relative Strength, etc.) can be the Active Window.

The active indicator window is used by:

*          All drawing and zoom functions.
*          The Date Align command.
*          The statistic groups.

The active window is designated by the word "Active" attached to the window title.

Note: For an indicator window to receive inputs it must be designated as "Active" and its fund group window 
must also be active.

To select the active window:

*          Double-click on the area of the desired indicator window.

To select the active fund group window:

*          Click on the area of the desired fund group window.

Note: When a new indicator is displayed, it automatically becomes active.



 

Chapter 4.    Tutorial
This chapter provides a brief tutorial on Monocle and its possible use. Remember that this 
tutorial is not a recommended investment strategy.    It is merely intended to demonstrate the 
functionality of Monocle.    Please review this chapter thoroughly to acquire an overview of the program.

4.1    Opening a Fund Group
To begin our analysis of mutual funds we need to open a fund group.    We will illustrate how this is done by opening
the Fidelity Investments group.

To open a fund group window: 

1.          Choose Fund Groups from the Tool Bar or File menu.

 
A dialog box will be displayed listing the available fund groups

 
2.          Highlight Fidelity Investments from the list.
                To aid in your search, type the first few letters of 
                "Fidelity" in the Find edit box. 
3.          Choose OK.
                A window for the fund group will be created.



4.2    Group Window Overview
Within the fund group window, a Price History window will be created displaying the price history of the Current 
Fund and that of the Benchmark.    Any statistics previously selected for the Price History indicator will be displayed
at the bottom of the Price History window.    

Once a fund group window is opened, other windows can be created within it, such as indicator windows (Relative 
Strength, MACD, etc.) and statistic windows (statistic groups, Latest Pricing).    These windows within the fund 
group window are referred to as "child windows" (i.e., children of the fund group window).

 

The symbol of the Current Fund, FDCAX, will be displayed on the Status Bar while the name of the fund group, 
Fidelity Investments, and the Benchmark, U.S. Equity Index, will be displayed in the title bar of the fund group 
window.

To scroll amongst the funds in the Fidelity Investments group, choose Previous Fund or Next Fund from the Status
Bar or the File menu.    



To select a specific fund from the group:

1.          Choose Select Current Fund from the Status Bar or the File menu.

 

2.          Highlight the fund in the dialog box which appears.

 

3.          Choose OK.
                The fund selected will become the Current Fund.



4.3    Selecting An Indicator
Monocle contains many powerful indicators to assist in fund selection and timing.    To illustrate, we will use the 
Relative Strength indicator to determine whether the Current Fund, FDCAX, is outperforming the Benchmark.    The
Relative Strength indicator, as well as all other indicators in Monocle, can be chosen from the Charts menu or from 
the Indicators dialog box accessible from the Indicators icon on the Tool Bar.    For this example, make sure the 
current fund is FDCAX.

4.3.1    Editing Indicator Parameters - Main

Note: Before selecting an indicator for the first time, it is recommended that you edit the indicator's parameters to
suit your needs.

To edit the Relative Strength indicator:
1.          Choose Indicators from the Tool Bar or Edit Parameters from the 
                Charts menu.

 
A dialog box will be displayed listing the indicators available.

 
2.          Select Relative Strength from the list.
3.          Choose Edit.
                A dialog box for the Relative Strenght indicator will be displayed where its
                parameter can be defined.        



 

From an indicator’s dialog box we can select calculation periods, line colors and statistics.    The Relative Strength 
chart displays three lines: the Relative Strength, a fast moving average of the Relative Strength, and a slow moving 
average of the Relative Strength.    

To define the periods for the Fast Moving Average and the Slow Moving Average, enter new values in the respective
Period text boxes.

As a rule, the greater the period, the greater the smoothing.    Unfortunately, increasing the smoothing also increases 
the lag in the response time to changes in the trend.    For timing indicators (indicators which generate buy/sell 
signals for fund timing), the greater the period, the fewer signals generated.    

For the Relative Strength Indicator, set the Fast Moving Average to 50 days and set the Slow Moving Average to 200
days.    Fifty days is considered by many investment professionals to approximate the medium term trend, while 200 
is considered to approximate the long term trend.

Note: All periods are specified in market days.



4.3.2    Editing Indicator Parameter - Statistics

Once we have defined the periods and colors of the Relative Strength Indicator, we will choose the statistics to be 
displayed on the bottom of the indicator window.    All indicators windows may display statistics.

To have statistics displayedin the Relative Strength indicator window:

1.          Check the Display box from the dialog box of the indicator.
                This will display the selected statistics when the indicator window is
                opened.
2.          Select Edit.
                A dialog box will be displayed listing the available statistics for the 
                Relative Strength chart.    For our purposes, we want to display    Alpha, 
                Beta, R-Squared, and Standard Deviation for the Current Fund.    To do
                so, we need to add these statistics to the Selected Statistcs list.    

 
To add a statistic to the indicator window:

1.          Highlight the desired statistic from the Available Statistics list.
2.          Select Add.    

To delete a statistic from the indicator window:

1.          Highlight the desired statistic from the Selected Statistics list.
2.          Select Delete.    



Once we have selected the statistics to be displayed, select OK.    This will save the statistic changes and return us to
the main dialog box for the Relative Strength Indicator.    Having set the smoothing periods, line colors, and statistics
to be displayed, we are ready to save our changes to the indicator.    To do so, select OK.    The Indicators dialog 
box will once again be displayed.

4.3.3    Selecting an Indicator

Now that we have configured the Relative Strength Indicator to our desired specifications, we can display it.

To display the Relative Strength Indicator:

1.          Highlight Relative Strength from the Indicator list.

 
2.          Select OK 
                A Relative Strength window will be created within the fund group
                window.



4.4    Timing Indicators
Monocle contains four indicators which are commonly used for mutual fund timing.    They are Momentum, MACD,
Moving Average Crossover, and Relative Strength Crossover. To develop an understanding of the use of timing 
indicators, we will examine a market timing strategy using the MACD Indicator.

To edit and display the MACD Indicator:

1.          Click on the Indicator icon from the toolbar.

 
                This will display a dialog box of available indicators.

 
2.          Highlight MACD.
3.          Click on Edit.
                A dialog box will be displayed where we will set the parameters of the
                MACD and choose the statistics to be displayed.

 



4.          Enter "20" in the Fast Mov Avg text box.
                This will allow us to capture the short term trend.
5.          Enter "50" in the Slow Mov Avg text box.
                This will allow us to capture the medium term trend.
6.          Enter "25" in the Trigger Mov Avg text box.
                This will determine the trigger time period for the MACD.
7.          Check Fund Switching.
                This will generate statistics that reflect switching between the Current 
                Fund and the Benchmark instead of simply trading in and out of the
                Current Fund.
8.          Check Display.
                This will display the selected statistics when the MACD window is opened.
9.          Choose Edit.
                A Statistics dialog box will appear where we will select the statistics to be 
              displayed.

 



10.          Highlight Return Benchmark from the Available Statistics list.
11.          Select Add.
                    This will add the statistic to the list of those selected to be displayed in
                    the indicator window.
12.          Repeat the last two commands to add the following statistics: Return 
                    Fund and Return Timing.
13.          Select OK in the Statistics dialog box.
                    This will save the statistics chosen.
14.          Select OK in the MACD dialog box.
                    This will save any changes made to the parameters of the MACD.
15.          Select OK in the Indicator selection dialog box.
                    This will open the MACD window with the defined parameters.

Once the parameters have been set for an indicator, they become the new defaults for the indicator.    Therefore, the 
next time you want to display the indicator, simply select it from the Indicators dialog box.



4.5    Drawing Functions
Monocle contains a wealth of drawing tools to aid in your charting analysis.    To illustrate the use of the drawing 
functions, we will draw a trendline.

Note:    All drawing functions are accessible as icons from the Draw Bar on the left-hand side of the program 
window or from the Draw menu.    Drawing functions only operate on the active window.

A trendline is defined by 2 points.    Rising trendlines are usually drawn between two significant lows to determine a 
price support level, while falling trendlines are drawn between two significant highs to determine a    price resistance
level.    The theory behind trendlines is that a trend will continue until the trendline is violated (i.e., when the NAV 
crosses the trendline).    When a breakout from the existing trendline occurs, a trend reversal may be imminent.

To draw a trendline:

1.          Choose Trendline from the Draw Bar.

 

2.          Click and release the mouse at a significant point
                in the active window where you would like to begin 
                the line.
3.          To end the line, click and release the mouse at 
                another significant point.    The completed trendline
                will be drawn at the position selected.

The other drawing functions such as Pitchforks and Fibonacci Arcs are drawn in a similar 
manner. 



4.6    Fund Description
In addition to examining the price history of a fund and various indicators, Monocle allows you to review 
background information on the Current Fund. Monocle provides a description for every fund in the database to assist
in your mutual fund investing.

Included in the fund description are:

1.            Full Fund Name 
2.            Fund Family
3.            Symbol
4.            Address
5.            Phone Number
6.            Date Established
7.            Maximum Sales Load 
                  Load requirements displayed are the maximums.    Many investment
                  companies offer lower or waive loads for larger investments. Please
                  consult the fund’s prospectus for detailed information.
8.            Objective/Policy
9.            Minimum Initial/Subsequent Investment Requirements
                  The minimum investment requirements are based upon investments
                  mailed directly to the fund company.    IRA investments, money sent via
                  wire, or other means may be subject to different requirements.    Please
                  consult the fund’s prospectus for detailed information.
10.        Distribution History 
 A.    X Dividend Date
 B.    Amount of Distribution
 C.    NAV on Date of Distribution
 D.    Distribution Percentage

Please be aware that the information is updated periodically and may include some 
commentary as well.    The information provided may change without warning.    Therefore, 
Manhattan Analytics, Inc. recommends acquiring a current prospectus before investing in 
any fund.



To view a description of the Current Fund:

*            Choose the Fund Info icon from the Tool Bar.

 

A window will be created containing information on the Current Fund.    

 



4.7    Load Individual Fund
In addition to examining the performance of the Current Fund relative to the Benchmark.    FindPro allows you to 
directly compare one fund against another.    For example, perhaps you would like to compare the performance of 
the Fidelity Select Computer fund, FDCPX, versus the Current Fund.

The Load Individual Fund command allows you to select any fund from the Monocle database and display it on 
the same chart with the Current Fund and the Benchmark.    The NAV's of the funds are normalized to make it simple
to compare the performance of the funds over a specified time period.    

To view FDCPX versus the Current Fund:

1.          Select Load Individual Fund from the Tool Bar or from the
                File menu.    

 
                The following dialog box will be displayed.



2.          Select FDCPX from the list.
                To ease your search, check the Symbol box and type in the first few
                letters of the fund symbol into the Find box above the list.    
3.          Check the Current Fund box.
                This will select the Current Fund to be displayed in the window along
                with FDCPX. 
4.          Clear the Benchmark box.
                This will prevent the benchmark from being displayed.
5.          Select OK.    

A new indicator window will be created displaying FDCPX against the Current Fund. 

To easily identify the Current Fund line and the new fund line:

*              Select Toggle Legend Window from the Window menu.
                  A legend will be displayed in the upper left-corner of the indicator.



4.8    Statistic Groups
Monocle also gives you the ability to calculate statistics on all of the funds within the active fund group.    Coupled 
with screening and ranking features, you can now easily determine the best performing funds based on your specific 
investment criteria using the numerous available statistics, including those used in Modern Portfolio Theory.    

To calculate statistics for the funds in the group, a statistic group must be defined and selected.    

A Statistic Group is comprised of the following:

*          Name - The name of the Statistic group.
*          Set of statistics - The statistics to be calculated
*          Period - The length of time over which the statistics will be calculated.

Monocle comes with several pre-defined statistic groups. Like fund groups, existing statistic 
groups can be edited, new groups added, and old groups deleted to suit your specific needs. 

 

 

 



4.8.1    Creating Statistic Groups

To illustrate the power of Monocle’s statistics groups, we will create and display a new group.

To create a Statistic Group:

1.          Select Statistic Groups from the Tool Bar or the Statistics menu.

 

              This will open a Statistic Group dialog box.

 

2.          Select Add.
                This will add a new statistic group and display a dialog box where we will
                define the composition of the group.

 



3.          Enter "Custom Group" in the Name text box.
                This will name the statistic group.
4.          Highlight Alpha from the Available Statistics list.
5.          Choose Add.
                This will add Alpha to the Selected list of chosen statistics.
6.          Repeat the last two commands to add the following statistics: 

Beta, StdDev, R-Squared, and 1 Month Return.
7.          Select 1 Year from the Period list.
                This will define 1 Year as the period over which the statistics like
                Alpha and Beta are calculated.
8.          Select OK.
                This will save the new statistic group.



4.8.2    Statistics Window

Once the statistic group has been defined, select it from the list of groups and choose OK.    The statistics will be 
calculated for each fund in the fund group and displayed in a statistics window.

Within the statistics window, there is a column for each statistic calculated.    Scroll bars are provided to navigate 
through the list. 

 

Once the statistics are calculated, the list can be ranked (Rank) or screened 
(Scrn) to your specifications.    This is accomplished by selecting the appropriate command in the lower left-hand 
corner of the statistics window.    

Note: The All button refreshes the window to display the complete list if any funds have been screened out with 
the Scrn command.



Statistics Window - Screening

To illustrate the use of the screening feature, we will assume that our investment strategy 
calls for investing in funds with a Beta of less than 1 and a 1 Month Return of greater than 2.
5 %.    We will screen our list of Fidelity funds to display only those funds which meet this 
criteria.

To screen the fund group:

1.          Select Scrn from the Statistics Window.    
                A dialog box will be displayed where we will specify our screening criteria.    

 

2.          Highlight Beta.
3.          Enter "1" in the Less Than [ < ] edit box. 
4.          Select Save Entry.    
                This is required to save each individual entry.    
5.          Highlight 1 Month Return.
6.          Enter "2.5" in the Greater Than [ > ] edit box.    
7.          Select Save Entry.    
8.          Choose OK.    
                The list will be screened to display with only those funds that meet our
                specifications.



Statistics Window -Ranking

Monocle makes it easy to rank the funds on any statistic within the group.    For example, 
after screening on Beta and 1 Month Return, you may want to know which of the remaining 
funds have the greatest 1 Month Return. Determining this is easy with the Rank feature 
available from the statistics window.    Any of the columns from the statistics window can be 
used to rank the fund list in either ascending or descending order. 

To rank the fund list:
1.          Select Rank from the statistics window.
                A dialog box will be displayed where we will make our selection.    

 
2.          Highlight  1 Mnth Return.    
                This will determine the statistic on which to rank the funds.
3.          Select Descending.
                This will determine the order of ranking (Greatest to Least).
4.          Click on OK.
                The list will now be ranked accordingly.

With the funds sorted according to 1 Month Return, we can now easily determine the top 
preformers for the last month.



4.9    Windowing Commands
Monocle harnasses the full power of Windows by allowing you to display multiple windows simultaneously.    As a 
result, all of the opened windows within the active fund group can be moved and sized to your specifications.

To illustrate this feature we will tile the open child windows.

To tile the child windows within the active fund group:

*            Select Tile Child Windows from the Tool Bar or Window menu.
 

 
    
The child windows will be redrawn to fill the available area of the active fund group.    You 
can use the Previous and Next fund commands to scroll amongst the funds in the active 
fund group.    All open child windows will be updated to display the Current Fund.





To save the open child windows as a template:

*          Select Save Template from the File Menu.
The open child windows will be saved in their current positions.    You can load the template 
when opening a fund group by selecting Load Template in Fund Groups dialog box.

 

Note: There can be only one template saved at a time.



4.10    Monocle Downloader - not included for use in demo
If you do not subscribe to Monocle’s Modem Retrieval Service, skip 
this section.

In this selection, we will run through the process of updating your data with the Monocle 
Downloader.

The Monocle Downloader makes it easy to keep your database current.    Whether you call 
every day, once a week, or once a month, the Monocle Downloader will update your 
database with data for all of the days you may have missed.    Furthermore, all mutual fund 
data is automatically adjusted for distributions, thus eliminating a common problem related 
to other data sources.

To start the Monocle Downloader:

*          Select Monocle Downloader from the Tool Bar.

 
            This will call the Monocle Downloader.
            The Monocle Downloader is a separate program used to download the latest 
            data from the Manhattan Analytics, Inc. main database.

 



4.11 Latest Pricing
Note: Once the mutual fund database has been updated, any open fund group windows must be closed and then re-
opened before the newly downloaded data will be reflected in the analysis.    This is necessary to load the new data 
into memory.

After the Fidelity Investments group has been closed and re-opened to account for the new data, we may display the 
latest prices for the funds in the group.    

To open a statistic window with the latest NAV's:
*          Click on the Latest Pricing icon from the Tool Bar.

 
              A statistics window will be created listing closing statistics for the funds in
              the active fund group.



 

Note: Close is the last price available from the database.    Last is the previous price.    Change is the difference 
between Close and Last, while %  Change is the percent difference from Last to Close.

As with other statistic windows, the Latest Pricing window can be screened and ranked.    Thus, it is easy to 
determine which funds are up for the day and which were the greatest percentage gainers. 

4.12    Conclusion
The presentation of the main features of Monocle is now complete.    After completing this section you should be 
able to navigate through Monocle.    The remaining sections of the manual present expanded and in-depth analysis of
each program feature.    We encourage you to experiment with the program and consult the manual or the on-line 
Help to get the most out of Monocle.    Best of luck in your mutual fund analysis!



 
Reminder:    Manhattan Analytics has the ability to add additional funds to the 
database.    Please contact Manhattan Analytics at 1-800-251-FUND(3863) to 
request specific funds.

List of Funds (A thru I)
List of Funds (J thru Z) 

30 Year TBond Intr Rate
AAL Capital Growth
AARP Capital Growth
Acorn Fund
Acorn International
AIM Agressive Growth
AIM Charter
AIM Constellation
AIM Growth
AIM International
AIM Utility
AIM Value
AIM Weingarten
Alger Small Capitalization
Alliance Fund
Alliance Growth
Alliance Quasar
Alliance Shrt Trm Multi Market
Alliance Technology
Alliance World Income Trust
American AMCAP
American Balanced
American Bond Fund of Amer.
American Cap Emrg Grwth A
American Cap Global Eqt A
American Cap Growth & Inc
American Cap Harbor A
American Capital Govt. Sec.
American Capital World Bond
American EuroPacific Growth
American Fundmntal Invstrs
American Grwth Fnd of Amer.
American Heritage Fund
American High Inc. Trust
American Inc. Fund of Amer.
American Invest Co.of Amer.
American Mutual
American New Economy
American New Perspective
American SmallCap World
American U.S. Govt Sec.
American Wash Mut Inv
AMEX JAPAN INDEX



AMEX MAJOR MKT INDEX
AMEX OIL & GAS INDEX
AMEX S & P MIDCAP INDEX
Analytic Optioned Equity
ASM Fund
Babson Bond Trust    Port. L
Babson Enterprise
Babson Enterprise II
Babson Growth
Babson Shadow Stock
Babson Stewart Ivry Intrntl
Babson Value
Baron Asset    Fund
Bartlett Cap. Basic Value
Bartlett Cap. Value Inter
Benham Adj. Rate Govt Sec.
Benham CA Muni. Hi Yld
Benham CA Tax Free Ins
Benham CA Tax Free Int Trm
Benham CA Tax Free L Trm
Benham CA Tax Free Shrt Trm
Benham Cap. Utilities Inc.
Benham Capital Preservation
Benham Equity Growth Fund
Benham European Govt Bond
Benham GNMA Income
Benham Gold Equities Index
Benham Income and Growth
Benham L/T Treasury
Benham National T/F Int. Trm
Benham Natl T/F Long Term
Benham Treasury Note
Benham Trgt Maturities 1995
Benham Trgt Maturities 2000
Benham Trgt Maturities 2005
Benham Trgt Maturities 2010
Benham Trgt Maturities 2015
Benham Trgt Maturities 2020
Berger 100
Berger 101
Berger Small Company
Bernstein Intermediate Dur
Berwyn Income
BIOTECHNOLOGY INDEX
Blanchard Flexible Income
Blanchard Global Growth
Blanchard Shrt Trm Glbl Inc.
Brandywine
Brinson Global Fund
Bull & Bear Gold Investors
Bull & Bear Municipal Inc.
Bull & Bear Spec. Eqties
Bull & Bear U.S. & Overseas
Bull & Bear U.S. Government
Calamos Convertible
California Tax Free Inc.



California U.S. Govt Sec.
Calvrt Soc.Invst.Mngd Grwth
CappielloRushmore Emrg Grwth
CappielloRushmore Grwth
CappielloRushmore Util Inc
Century Shares Trust
CGM Capital Development
Clipper Fund
Cohen & Steers Realty Shars.
Colonial Utilities
Columbia Common Stock
Columbia Fixed Inc. Sec.
Columbia Growth
Columbia Intl Stock
Columbia Municipal Bond
Columbia Special
Cornerstone Growth
CrabbeHuson Equity
CrabbeHuson Special Eq
Delaware Trend
DFA Continental Small Co
DFA Japanese Small Co
DFA Pacific Rim Small Co
DFA UK Small Co
Dodge & Cox Balanced
Dodge & Cox Income
Dodge & Cox Stock
Dow Jones INDUSTRIALS    30
Dow Jones STOCK COMPOSTE    65
Dow Jones TRANSPORTATION 20
Dow Jones UTILITY 15
Dreman Contrarian Portfolio
Dreman High Return Portfolio
Dreyfus A. Bonds Plus
Dreyfus Appreciation
Dreyfus Balanced
Dreyfus CA Int. Municipal Bond
Dreyfus CA Tax Exempt Bond
Dreyfus Capital Value
Dreyfus FL Int. Muni Bond
Dreyfus Fund
Dreyfus General CA Muni Bnd
Dreyfus General Muni Bond
Dreyfus General NY Muni Bnd
Dreyfus GNMA
Dreyfus Growth and Income
Dreyfus Growth Opportunity
Dreyfus Insured Muni Bond
Dreyfus Inter. Muni Bond
Dreyfus International Eqty
Dreyfus MA Int. Municipal
Dreyfus MA Tax Exempt Bond
Dreyfus Municipal Bond
Dreyfus New Leaders
Dreyfus NJ Inter. Muni
Dreyfus NJ Municipal Bond



Dreyfus NY Insured T/E Bond
Dreyfus NY T/E Int. Bond
Dreyfus NY Tax Exempt Bond
Dreyfus People's Index
Dreyfus Premier CT T/E Bond
Dreyfus Short Term Income
Dreyfus Shrt Inter. Govt
Dreyfus Shrt Inter. T/E Bnd
Dreyfus Spec Grwth Inv
Dreyfus Third Century
Dreyfus Wilshire Sm Co Value
Eaton Vance Greater China
Eclipse Equity Fund
Evergreen Amer. Retirement
Evergreen Foundation Fund
Evergreen Fund
Evergreen Insured Nat. T/F
Evergreen Limited Market
Evergreen Real Estate Eqty
Evergreen Shrt/Int Muni Bnd
Evergreen Shrt/Int Muni. CA
Evergreen Total Return
Evergreen Value Timing
Federated ARMs Instit. Shrs
Federated Bond Fund
Federated GNMA Instit. Shrs.
Federated Growth Trust
Federated High Yield Trust
Federated Inc. Trust Instit.
Federated Int.Gvt Inst.Shrs
Federated Inter Muni Trust
Federated Intrntnl Equity
Federated Max Cap
Federated Mini Cap Fund
Federated S/I Gvt Inst.Shrs
Federated Shrt Int.MuniTrst
Federated Shrt Trm Inc.Inst
Federated Stock & Bond
Federated Stock Trust
Fidelity Advisor Eq Prt Inc
Fidelity Advisor Eqty Prt Grth
Fidelity Advisor Global Res
Fidelity Advisor Gov Inv
Fidelity Advisor Growth Opp
Fidelity Advisor Hi Inc Muni
Fidelity Advisor High Yield
Fidelity Advisor Inc & Growth
Fidelity Advisor Ltd Tax Ex
Fidelity Advisor Ltd Time Bnd
Fidelity Advisor Overseas
Fidelity Advisor Sht Fixed Inc
Fidelity Advisor Strat Opp
Fidelity Aggressive T/F
Fidelity Asset Manager
Fidelity Asset Manager Grwth
Fidelity Asset Manager Inc.



Fidelity Balanced
Fidelity Blue Chip Growth
Fidelity CA T/F Insrd Port.
Fidelity CA Tax Free Hi Yld
Fidelity Canada
Fidelity Capital and Income
Fidelity Capital Apprec
Fidelity Contrafund
Fidelity Convertible Sec
Fidelity Destiny I
Fidelity Destiny II
Fidelity Disciplined Equity
Fidelity Dvrsfd Intrntl
Fidelity Emerging Growth
Fidelity Emerging Markets
Fidelity Equity Income
Fidelity Equity Income II
Fidelity Euro Cap Apr
Fidelity Europe
Fidelity Fifty
Fidelity Fund
Fidelity Ginnie Mae
Fidelity Global Balanced
Fidelity Global Bond
Fidelity Government Sec.
Fidelity Growth & Income
Fidelity Growth Company
Fidelity High Yield T/F
Fidelity Intermediate Bond
Fidelity Intl. Grwth & Inc.
Fidelity Investment Grd Bnd
Fidelity Japan
Fidelity Latin America
Fidelity Limited Trm Muni
Fidelity Low Priced Stock
Fidelity MA Tax free Hi Yld
Fidelity Magellan
Fidelity Market Index
Fidelity MI Tax Free Hi Yld
Fidelity MN T/Free Port
Fidelity Mortgage Sec.
Fidelity Municipal Bond
Fidelity New Millenium
Fidelity New Mrkts Income
Fidelity NY T/F Insured
Fidelity NY Tax Free Hi Yld
Fidelity OH Tax Free Hi Yld
Fidelity OTC
Fidelity Overseas
Fidelity Pacific Basin
Fidelity Puritan
Fidelity Retirement Growth
Fidelity Rl. Estate Invstmnt
Fidelity Select Air Trans
Fidelity Select Amer. Gold
Fidelity Select Automotive



Fidelity Select Biotech
Fidelity Select Multi_Media
Fidelity Select Brkr_Invst.
Fidelity Select Chemicals
Fidelity Select Cnsmr Prod.
Fidelity Select Cnstrct/Housng
Fidelity Select Computers
Fidelity Select Dfns & Aero.
Fidelity Select Dvlp. Comm.
Fidelity Select Electronics
Fidelity Select Energy
Fidelity Select Enrgy Serv.
Fidelity Select Envirn Svcs.
Fidelity Select Finan. Serv.
Fidelity Select Food & Agri.
Fidelity Select Health Care
Fidelity Select Home Finance
Fidelity Select Indst Equip.
Fidelity Select Indst. Mats
Fidelity Select Insurance
Fidelity Select Leisure
Fidelity Select Med Delivry
Fidelity Select Natural Gas
Fidelity Select Paper_Forest P
Fidelity Select Prec. Mtls/Min
Fidelity Select Region Bnks
Fidelity Select Retailing
Fidelity Select Softwr_Comp
Fidelity Select Technology
Fidelity Select Telecomm.
Fidelity Select Trans
Fidelity Select Utilities
Fidelity Short Term Bond
Fidelity Shrt Trm World Inc
Fidelity Small Cap
Fidelity Southeast Asia
Fidelity Spartan GNMA
Fidelity Spartan Govt Inc.
Fidelity Spartan High Inc.
Fidelity Spartan Long Term
Fidelity Spartan Muni Inc.
Fidelity Spartan S/I Muni
Fidelity Spartan S/T Bond
Fidelity Sprtn FL Muni Inc.
Fidelity Sprtn Ltd.Mat.Gvt
Fidelity Sprtn Shrt Int Gvt
Fidelity SprtnCA Muni Hi Yld
Fidelity SprtnCT Muni Hi Yld
Fidelity SprtnInvst.Grad.Bnd
Fidelity SprtnNJ Muni Hi Yld
Fidelity SprtnNY Muni HiYld
Fidelity SprtnPA Muni Hi Yld
Fidelity Stock Selector
Fidelity T/F Insured
Fidelity Trend
Fidelity U.S. Equity Index



Fidelity U.S. Govt Reserves
Fidelity Utilities Inc.
Fidelity Value
Fidelity Worldwide
Flag Telephone Income
Flex-Funds Growth
Fortis Advantage Asset Alloc
Fortis Capital
Fortis Growth
Founders Blue Chip
Founders Discovery
Founders Equity Income
Founders Frontier
Founders Govt Sec.
Founders Growth
Founders Passport
Founders Special
Founders Worldwide Growth
Franklin Adj U.S. Govt
Franklin Adj. Rate Sec.
Franklin AGE High Income
Franklin CA Insured T/F Inc.
Franklin CA Tax Free Inc.
Franklin Convertible Sec.
Franklin DynaTech
Franklin Equity
Franklin Equity Income
Franklin Federal T/F Inc.
Franklin FL Tax Free Income
Franklin Global Govt Income
Franklin Global Utility
Franklin Gold
Franklin Growth
Franklin Hi Yld T/F Inc.
Franklin Income
Franklin Insured T/F Inc.
Franklin Invstmnt Grd Inc.
Franklin MA Insured T/F Inc.
Franklin MD T/F Income
Franklin MI Insured T/F Inc.
Franklin MN Insured T/F Inc.
Franklin NJ Tax Free Inc.
Franklin NY Tax Free Inc.
Franklin PA Tax Free Inc.
Franklin Premier Return
Franklin Rising Dividends
Franklin S/I U.S. Govt.
Franklin U.S. Govt Sec.
Franklin Utilities
Franklin VA Tax Free Inc.
Fremont CA Intermediate T/F
Fremont Global
FundTrust Aggress Grwth
FundTrust Growth & Inc.
FundTrust Growth
FundTrust Income



G.T. America Growth
G.T. Europe Growth
G.T. Glbl.Strat.Inc.Cls A
G.T. Global Emerging Mrkts
G.T. Global Gov. Inc.
G.T. Global Growth & Inc.
G.T. Global Health Care
G.T. Global High Income
G.T. Global Worldwide Growth
G.T. Infra Structure
G.T. International Growth
G.T. Japan Growth
G.T. Latin America Growth
G.T. New Pacific Growth
G.T. Telecommunications
Gabelli ABC
Gabelli Asset
Gabelli Equity Income
Gabelli Global Telcom
Gabelli Growth
Gabelli Small Cap Growth
GAM International
GAM Pacific Basin
Gateway Growth
Gateway Index Plus
George Putnam Fund of Bstn
Gintel ERISA
Gintel Fund
GIT Equity Special Growth
Global Bond
Govett Emerging Markets
Govett Pacific Strategy
Govett Smaller Co
GradisonMcDonald Estab Val.
GradisonMcDonald Opp. Val.
Guardian Park Ave
Hancock Svrgn Invstmnts
Harbor Bond
Harbor Cap. Apprec.
Harbor Growth
Harbor International
Harbor Value
Heartland Value
Hntngtn Intl. Crncy    Hi Inc.
Hntngtn Intl.Crncy Port.Glbl
Hntngtn Intl.Crncy Port.Hard
IAI Balanced
IAI Bond
IAI Emerging Growth
IAI Government�
IAI Growth and Income
IAI International
IAI Mid Cap Growth
IAI Regional
IAI Reserve Fund
IAI Value



IDS Bond
IDS Discovery
IDS Extra Income
IDS Federal Income
IDS Growth
IDS Mutual
IDS New Dimensions
IDS Selective
IDS Stock
IDS Strategic Aggressive Eq
IDS Utilities Income
INVESCO Bond Hi Yld
INVESCO Bond U.S. Govt
INVESCO Dynamics
INVESCO Emerging Growth
INVESCO European Fund
INVESCO Growth
INVESCO Industrial Income
INVESCO Money Mrkt T/F Money
INVESCO Pacific Basin
INVESCO Select Income
INVESCO Series Trst Equity
INVESCO Strat Energy
INVESCO Strat Finan Svcs.
INVESCO Strat Hlth Sci
INVESCO Strat Tech�
INVESCO Strat Utilities
INVESCO Strat.Environ.Serv.
INVESCO Strategic Gold
INVESCO Strategic Leisure
INVESCO T/F Inc.Shares
INVESCO Total Return
INVESCO Trst Int. Govt Bond
INVESCO Trst Intrntnl Grwth
Ivy Growth & Income
Ivy Growth
Ivy International                        

List of Funds (A thru I)
List of Funds (J thru Z) 

New funds are continuously being added to our database!
If your fund isn't listed give us a call!

1 - 800 - 251 - FUND(3863)



 
Reminder:    Manhattan Analytics has the ability to add additional funds to the 
database.    Please contact Manhattan Analytics at 1-800-251-FUND(3863) to 
request specific funds.

List of Funds (A thru I) 
List of Funds (J thru Z)

Janus Balanced
Janus Enterprise
Janus Federal Tax Exempt
Janus Flexible Income
Janus Fund
Janus Growth & Income
Janus Inter. Govt Sec.
Janus Mercury
Janus Short Term Bond
Janus Twenty
Janus Venture
Janus Worldwide Fund
Kaufmann Fund
Keystone Amer Global Opp
Keystone Amer Omega
Legg Mason Special Inv
Lexington Convert. Sec.
Lexington Corp. Leaders
Lexington Global�
Lexington GNMA Inc.
Lexington Gold
Lexington Growth & Inc.
Lexington S/I Govt Sec
Lexington Stragetic Silver
Lexington Strat. Invstmnts
Lexington Tax Exempt Bond
Liberty American Leaders
Liberty Equity Income
Liberty Utility
Lindner Dividend
Lindner Fund
Lindner Utility
LMH Fund
LNDN FINANCIAL TIMES INDX
Longleaf Ptns Sh Ben Int
Longleaf Ptns Small Cap
Loomis Sayles Bond
Loomis Sayles Growth
Loomis Sayles Intrntnl Eqty
Loomis Sayles Small Cap.
Lord Abbett    Affil.
Lord Abbett U.S. Govt
Lxingtn Wrldwd.Emrgng Mrkts



Main Street Income & Growth
MAS Pooled Trst Eqty
MAS Pooled Trst Intnl Eqty
MAS Pooled Trst Ltd Durtn
MAS Pooled Trust Fixed Inc.
MAS Pooled Trust Small Cap.
MAS Pooled Trust Value Port.
Mathers
Maxus Equity
Merger
Meridian
Merrill Lynch Capital
Merrill Lynch Dragon
Merrill Lynch Dvlp Capital
Merrill Lynch Eurofund
Merrill Lynch Global Alloc
Merrill Lynch Global Conv
Merrill Lynch Global Utility
Merrill Lynch Growth
Merrill Lynch Healthcare
Merrill Lynch Latin America
Merrill Lynch Pacific
Merrill Lynch Pheonix
Merrill Lynch Special Value
Merrill Lynch Technology
Merrill Lynch Tomorrow
Merrill Lynch World Income
Merriman Asset Alloc.
Merriman Blue Chip
Merriman Cap. Apprec.
Merriman Flexible Bond
MFS Research
MFS World Total Return
MIM Stock Apprec.
Monetta Fund Inc
Montgomery Emrgng Mrkts
Montgomery Global Comm.
Montgomery Global Equity
Montgomery Growth
Montgomery Intl Small Cap
Montgomery Shrt Durtn Govt
Montgomery Small Cap Fund
Morgan Stanley Asian Eqty
Morgan Stanley Emerging Mrkt
Mutual Beacon
Mutual Discovery
Mutual Qualified
Mutual Shares Fund
NASDAQ BANKING STOCKS
NASDAQ COMPOSITE INDEX
NASDAQ INDUSTRIALS
NASDAQ INSURANCE STKS
NASDAQ NASDAQ 100 INDX
NASDAQ TRANSPORTATIONS
Neuberger_Berman Genesis
Neuberger_Berman Guardian



Neuberger_Berman Ltd. Mat Bond
Neuberger_Berman Manhattan
Neuberger_Berman Muni Sec Trst
Neuberger_Berman Partners
Neuberger_Berman Selected Sect
Neuberger_Berman Ultra Shrt Bo
New USA Fund
New York Life Inst Value Eqty
New York Venture
Newport Tiger
Nicholas Fund
Nicholas II Fund
Nikkei (Temporary)
Northeast Investors Growth
Northeast Investors Trust
NYSAE UTILITY INDEX
NYSE Advancing
NYSE COMPOSITE
NYSE Declining
NYSE FINANCE
NYSE INDUSTRIALS
NYSE TRANSPORT
Oakhall Equity
Oakmark
Oakmark International
Oberweis Emerging Growth
Oppenheimer Discovery
Oppenheimer Equity Inc.
Oppenheimer Fund
Oppenheimer Global G&I
Oppenheimer Hi Yld
Oppenheimer Strat Inc.
Oppenheimer Time
Oppenheimer Total Rtrn
Pacific Hor U.S. Govt    Sec.
Pacific Hor. Aggress Grwth
Pacific Horizon CA T/E Bond
Papp L. Roy Stock
Parnassus Income Bal
Pasadena Growth
Pax World
PBHG Emerging Growth
PBHG Growth
Pennsylvania Mutual
Peoples S&P MidCap Index
Permanent Port. T Bill
Permanent Portfolio
Permanent Vrsatile Bnd Port.
Perritt Capital Growth
Phily SE Gold/Silver�
Phoenix Balanced
Phoenix Growth Fund
PIMCO Foreign
PIMCO Growth Stock
PIMCO High Yield
PIMCO Lng Trm U.S. Govt



PIMCO Low Duration
PIMCO Short Term Fund
PIMCO Total Return
PIMCO Total Return III
Pioneer Bond
Pioneer Capital Growth
Pioneer Equity Income
Pioneer Europe Fund
Pioneer Fund
Pioneer Gold Shares
Pioneer II
Pioneer Municipal Bond
Pioneer Three
PRA Real Estate Sec.
Primary Trend
Putnam Asia Pacific
Putnam CA Tax Exempt Inc
Putnam Conv Income/Grwth
Putnam Diversified Income
Putnam Europe Growth
Putnam Global Gov Inc
Putnam Global Growth
Putnam Growth & Income
Putnam Health Sciences
Putnam Hi Yield Adv
Putnam Investors A
Putnam Municipal Inc
Putnam Natural Resources
Putnam New Opportunities
Putnam OTC Emerging Growth
Putnam Overseas
Putnam US Gov Income
Putnam Uttilities G&I
Putnam Vista
Putnam Voyager
Regis Small Company
Reich & Tang Equity
Reynolds Blue Chip Growth
Robertson Stevens Contrarian
Robertson Stphns Emrg Grwth
Robertson Stphns Value Plus
Roulston Growth & Income
Royce Fund Eqty Inc. Series
Royce OTC
Royce Premier
Rushmore American Gas Index
Rushmore U.S. Govt. LTrm�
Rushmore U.S. Gvt. Int Trm
Rushmore Virginia T/F Port
Rydex Govt Bond
Rydex Govt Money Mkt
RYDEX Nova
Rydex OTC
Rydex Precious Metals
Rydex URSA
S & P    BANK COMPOSITE



S & P    CHEMICALS
S & P HEALTH CARE COMP
S&P    RETAIL SECTOR
S&P    TRANS SECTOR
S&P    TRANSPORTATION 20
S&P 100 INDEX
S&P 500
S&P INDUSTRIALS 400
S&P INSURANCE INDEX
S&P UTILITIES 40
SAFECO California T/F Inc.
SAFECO Equity
SAFECO Growth
SAFECO High Yield Bond
SAFECO Income
SAFECO Municipal Bond
SAFECO Northwest Fund
SAFECO U.S. Govt Sec
Salomon Brothers Invstrs
Salomon Brothers Opp.
SBSF Convertible Secs
SBSF Fund
Schafer Value
Schwab 1000 Fund
Schwab CA Shrt Int T/F Bnd
Schwab CA T/F Bond
Schwab Intl Index
Schwab Money Market
Schwab National T/F Bnd
Schwab Short Inter T/F Bnd
Schwab Small Cap Index
Schwab U.S. Govt Bond (S/I)
Scudder California Tax Free
Scudder Capital Growth
Scudder Development
Scudder Global
Scudder Global Small Co
Scudder GNMA
Scudder Gold
Scudder Growth & Inc.
Scudder Income
Scudder International
Scudder International Bond
Scudder Japan
Scudder Latin America
Scudder Managed Muni Bonds
Scudder Med Trm T/F
Scudder New York Tax Free
Scudder Pacific Opportunity
Scudder Quality Growth
Scudder Short Term Bond
Scudder Shrt Trm Global Inc.
Scudder U.S. Treasury
Scudder Zero Coupon 2000
SEI Bond Index Port
SEI Capital Apprec.



SEI Instit. Mngd Bond Cls A
SEI Instit.Ltd.Vltility Bnd
SEI International
SEI Mngd Trst Eqty Inc.
SEI Mngd Trst Val. Port.
SEI S&P 500 Index
SEI T/E Trst Int. Trm Muni
Selected American Shares
Selected Special Shares
Seligman Capital
Seligman Common Stock
Seligman Communication
Seligman Frontier
Seligman Growth
Seligman Income
Sentinel Common Stock
Sequoia Fund
Short Term Interest Rate
Sit New Beginning T/F Inc.
Sit New Bgning Inc.&Grwth
Sit Nw Bgning Growth
Sit Nw Bgning U.S.Gvt Sec.
Skyline Special Eqty II
Skyline Special Equities
SoGen Gold
SoGen International Fund
SoGen Overseas
Sound Shore
State Street Capital Apprec
State Street Equity Inv
State Street Investment
SteinRoe Capital Opp.
SteinRoe Government Income
SteinRoe High Yield Muni.
SteinRoe Income Fund
SteinRoe Intermediate Bond
SteinRoe Intermediate Muni.
SteinRoe Managed Muni.
SteinRoe Prime Equities
SteinRoe Special Fund
SteinRoe Stock Fund
SteinRoe Total Return
Stratton Growth
Stratton Monthly Dvdnds
Stratton Small Cap Yield
Strong Advantage
Strong American Utilities
Strong Asia Pacific
Strong Common Stock
Strong Discovery
Strong Government Secs
Strong Growth
Strong Income
Strong Insured Muni Bond
Strong International Stock
Strong Municipal Bond



Strong Opportunity
Strong S/T Muni Bond
Strong Short Term Bond
Strong Total Return
T. Row Prc Adj.Rate U.S.Govt
T. Rowe Price Cap. Apprec.
T. Rowe Price Eqty Inc.
T. Rowe Price Euro Stck
T. Rowe Price Glbl Gvt Bnd
T. Rowe Price GNMA
T. Rowe Price Growth Stock
T. Rowe Price Grwth & Inc.
T. Rowe Price High Yield
T. Rowe Price Intl Discovery
T. Rowe Price Intrntnl Bond
T. Rowe Price Intrntnl Stck
T. Rowe Price Japan
T. Rowe Price MD T/F Bond
T. Rowe Price New Asia
T. Rowe Price New Era
T. Rowe Price New Horizons
T. Rowe Price New Income
T. Rowe Price Nw Amer.Grwth
T. Rowe Price OTC Securities
T. Rowe Price Sci & Tech.
T. Rowe Price Shrt Trm Bond
T. Rowe Price Small Cap Val.
T. Rowe Price Spectrum Grwth
T. Rowe Price Spectrum Inc.
T. Rowe Price T/F Shrt Int
T. Rowe Price Tax Free Inc.
T. Rowe Tax Free High Yield
Templeton Develop.Mrkts Trst
Templeton Foreign
Templeton Global Opportunity
Templeton Growth
Templeton Income
Templeton Real Estate Sec
Templeton Smaller Cos. Grwth
Templeton World
Third Ave Value
Tweedy Browne Global Value
Twentieth Cent.Blncd Invstrs
Twentieth Cent.Grwth Invstrs
Twentieth Cent.Heritg Invstr
Twentieth Cent.Slct Invstrs
Twentieth Cent.Ultr Invstrs
Twentieth Cent.Vist Invstrs
Twentieth Century Intl Equity
Twentieth Century L/T Bond
Twentieth Century US Govt
Twentieth Century Value
United Serv. All Amer. Eqty
United Serv. Glbl Resources
United Services Gold Shares
United Services Income



United Services Real Estate
United Services Tax Free
United Services World Gold
USAA Investment Balanced
USAA Investment Cornerstone
USAA Mutual Income
USAA Mutual Income Stock
Value Lin Lvgd Grwth Invstrs
Value Line
Value Line Aggress.Inc.Trust
VALUE LINE ARTHMTIC WGHT
Value Line Convertible
Value Line Geometric Index
Value Line Income
Value Line Special Situatns
Value Line T/F Hi Yld
Value Line U.S. Govt Sec.
VAN ECK Asia Dynasty
Vanguard    S/T U.S. Treasury
Vanguard    Short Term Corp
Vanguard 500 Fund
Vanguard Asset Allocation
Vanguard Bond Index
Vanguard CA Insured L Trm
Vanguard CA T/F Mny Mrkt
Vanguard Convertible Sec.
Vanguard Equity Income
Vanguard Explorer
Vanguard Fixed Inc GNMA
Vanguard Fixed Inc. S/T Fed
Vanguard Fxd In.Invst.Grd Corp
Vanguard Fxd Inc Intr US Tr
Vanguard Fxd Inc. Hi Yld Corp.
Vanguard Fxd Inc.L T U.S.Treas
Vanguard Growth Index
Vanguard Intrntnl Eqty Euro
Vanguard Intrntnl Eqty Pac.
Vanguard Money Market
Vanguard Money Market Prime
Vanguard Money Market Trsry
Vanguard Muni Bnd Lmtd Port
Vanguard Muni Hi Yld
Vanguard Muni Insured L Trm
Vanguard Muni Inter. Trm
Vanguard Municipal L Term
Vanguard Municipal Shrt Term
Vanguard NJ Insrd L Trm Muni
Vanguard NY insured L Trm
Vanguard PA T/F fund
Vanguard Preferred Stock
Vanguard PRIMECAP
Vanguard Spec. Hlth Care
Vanguard Spec.Gld/Prec.Mtls
Vanguard Spec.Util.Inc.Port.
Vanguard Specialized Energy
Vanguard Star Fund



Vanguard Trst.Cmgld Intrntnl
Vanguard Trustee's Cmngld U.S.
Vanguard Value Index
Vanguard Wellesley Inc.
Vanguard Wellington
Vanguard Windsor
Vanguard Windsor II
Vanguard World U.S. Grwth
Vanguard Wrld Intrntnl Grwth
Vanguard/Morgan Growth
Vista Capital Growth
Vista Growth & Income
Vista New York Tax Free Inc.
Vista Tax Free Income
Vontobel EuroPacific
Vontobel US Value
Warburg, Pincus Fixed Inc
Warburg,Pincus Cap Apprec
Warburg,Pincus Emrgng Grwth Cm
Warburg,Pincus Fixed Income
Warburg,Pincus Growth Inc
Warburg,Pincus Intl Eqty Inst
Warburg,Pincus Intl Equity
Warburg,Pincus Intrm Mat Govt
Warburg,Pincus NY Muni Bond
Wasatch Aggressive Equity
William Blair Growth Shares
William Blair Income Shares
WILSHIRE SMALL CAP
Working Assts Citizens Blncd P
WPG Government Securities
WPG Growth & Income Fund
WPG Growth
WPG Tudor
Wright Equi Hong Kong
Wright Equi Spain
Yacktman Fund
Zweig Prity Slctn Lst ClsA
Zweig Series Strategy Cls A

List of Funds (A thru I) 
List of Funds (J thru Z)

New funds are continuously being added to our database!
If your fund isn't listed give us a call!

1 - 800 - 251 - FUND(3863)




